
1 
 

User Manual 
 
 
 
 
 
 
 
 
 
 

 

 
http://medspaceVR.com™ 

http://medspacevr.com/


 
 

1 
 

Table of Contents 

Contents 

Table of Contents ............................................................................................................................................ 1 

medspace.VR™ COPYRIGHT NOTICE ............................................................................................................... 3 

Introducing medspace.CA™ ............................................................................................................................ 4 

Safety Warning ................................................................................................................................................ 5 

General Instructions ........................................................................................................................................ 5 

The medspace.CA™ Interface ......................................................................................................................... 6 

The Menus ....................................................................................................................................................... 8 

The medspace.CA™ Workspace .................................................................................................................... 10 

Keyboard Functions and Navigating ............................................................................................................. 11 

Keyboard functions (Directional keys) .......................................................................................................... 11 

Mouse Functions (Selecting objects and looking around)............................................................................. 11 

Moving and Turning ...................................................................................................................................... 12 

Workflow....................................................................................................................................................... 13 

Accessing equipment interactively within the 3D workspace ....................................................................... 13 

Individual Equipment Controls ...................................................................................................................... 14 

C-ARM Base Machine Controls ................................................................................................................... 14 

C-ARM Arm Controls ................................................................................................................................... 15 

Monitor Controls ........................................................................................................................................ 16 

Step By Step Guide ........................................................................................................................................ 17 

Starting medspace.VR™ .............................................................................................................................. 17 

Selecting a Module and Mode .................................................................................................................... 18 

Selecting a Tutorial ..................................................................................................................................... 18 

Room Preparation and Initial Equipment Placement ................................................................................. 19 

C-arm movement ........................................................................................................................................ 21 

Base Movements ........................................................................................................................................ 22 

C-Arm Height Adjustment ........................................................................................................................... 23 

Monitor Movement .................................................................................................................................... 23 

Skeleton View ............................................................................................................................................. 24 

kVp and mAs Controls ................................................................................................................................. 24 

Field Size/Magnification ............................................................................................................................. 25 



 
 

2 
 

Single Pulse and Continuous X-ray Screening ............................................................................................. 25 

Monitor Display Settings............................................................................................................................. 26 

Collimation size and rotation ...................................................................................................................... 27 

Taking the Exposure .................................................................................................................................... 27 

Trouble Shooting ........................................................................................................................................ 28 

Help and Support ......................................................................................................................................... 29 
 



 
 

3 
 

 

 
medspace.VR™ COPYRIGHT NOTICE 

Copyright © 2017 medspace.VR™ PTY LTD 

This copyright notice 

Ownership of copyright 

The copyright in this document and the material in this document (including without limitation the text, artwork, 
photographs, images and teaching material) is owned by medspace.VR™ [and its licensors]. 

 
Copyright license 
medspace. VR grants to you a worldwide non-exclusive royalty-free revocable license to: 

 

⚫ view this document and the material in the document on a computer or mobile device via a web browser. 
⚫ copy and store this document and the material in the document in your web browser cache memory; and 
⚫ print pages from this document for your own [personal and non-commercial] use. 

 
medspace.VR™ does not grant you any other rights in relation to this document or the material in this document. 
In other words, all other rights are reserved. 

 

For the avoidance of doubt, you must not adapt, edit, change, transform, publish, republish, distribute, redistribute, 
broadcast, rebroadcast or show or play in public this document, or the material within  this  document (in any form 
or media) without medspace.VR™ prior written permission. 

 
Data mining 
The automated and/or systematic collection of data from this document is prohibited. 

 

Permissions 
You may request permission to use the copyright materials in this document by writing to 
info[at]medspace.VR™[dot]com. 

 

Enforcement of copyright 
medspace.VR™ takes the protection of its copyright very seriously. 

 

If medspace.VR™ discovers that you have used its copyright materials in contravention of the license above, 
medspace.VR™ may bring legal proceedings against you seeking monetary damages and an injunction to stop you 
using those materials.  You could also be ordered to pay legal costs. 

 

If you become aware of any use of medspace.VR™ copyright materials that contravenes or may contravene the 
license above, please report this by email to info@medspaceVR.com. 

 

Infringing material 
 

If you become aware of any material in the document that you believe infringes your or any other person's 
copyright, please report this by email to info@medspace.VR™.com. 

mailto:info@medspaceVR.com
mailto:info@medspace.VR
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Introducing medspace.CA™ 
 

 
medspace.CA™ is a virtual operating theatre room complete with a realistic and fully moveable digital 
fluoroscopy C Arm radiography equipment, an impatient surgeon and interactive control panel for 
exposure settings. Students have different viewing options to allow for true immersion and workflow 
processes and can interact with all pieces of equipment via drop down menus or short cut keys. Key 
features include: 

• Interaction with all pieces of equipment via drop down menus or short cut keys 

• Simulated Operating Room – the equipment needs to be manipulated to achieve the resultant 

images not the patient. 

• Altering camera perspectives, including viewing as the radiographer; from the collimator; from 

the sides and above the operating table. Selection is via drop down menu or short cut Function 

keys. 

• Extra features like a “sarcastic” surgeon. 

• A resulting virtual image directly relating to individual C Arm positioning and exposure selection 

• The ability to use “pulse/shot” x ray or “screening” mode 

• Student image comparison with pre-programmed “Ideal” 

• Student immersion in the “process” of placing equipment in an appropriate position to enable 

full equipment movement and to be in view for the surgeon 
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Safety Warning 
Viewing of 3D virtual software can make users feel unwell. If any of the following is experienced, 

please inform your educator, and temporarily cease using the software. The following symptoms may 

occur individually or in combination: 
 

• general discomfort 

• dizziness 

• difficulty focusing 

• vertigo 

• headache 

• fatigue 

• nausea 

 
General Instructions 

• Click on a piece of equipment, patient, or body part to activate the relevant control panel. 

• Alternatively, select from the drop down menus. 

• Click outside of the panel to close it. 

• Distance travel locks have been implemented on the machine so it will lock at selected points. 

• The “Short Cut” keys follow the order of the drop down menu 
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The medspace.CA™ Interface 

To start medspace.VR™ go to the Windows start menu and navigate to the medspace.VR™ menu. Click 
on the medspace.VR™ link, with your Left Mouse Button (LMB). Alternatively, you can double click the 
medspace.VR™ desktop icon with your LMB    

 

 

Load time will depend on the hardware configuration you are using. Refer to the ‘Administrator’s Manual’ 

for recommended hardware configurations. 
 

Upon loading you will be presented with the Module selection screen. LMB click on the ‘CA’ button 

 
The medspace.VR™ module selection Interface. 

 

On the following Mode panel LMB click the ‘Tutorial’ button. 

 
The medspace.CA™ mode selection panel. 
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The Procedure panel will be displayed. 

 

Select the desired procedure by selecting a combination from the ‘Select Body’ column and the ‘Select 

Anatomy’ column and click ‘Ok’ as detailed in the example above. 

      Students can only select a procedure that the Administration has previously created in 

medspace.CA™. Administrators refer to the separate ‘Administrator’s Guide’ for information on 

the administration interface and operation. 
 

When the medspace.CA™ module loads you will be presented with the 3D working interface. 
 

The medspace.CA™ 3D Workspace Interface. 
 

The medspace.CA™ interface is composed of two distinct areas. These are: 
 

I. The ribbon bar File menus 
 

II. The 3D workspace 

File Menus 
 
 
 
 

Main 3D Workspace 
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The menus allow access to common functions such as ‘navigation’ and ‘help’ as well as detailed access 

and control of all aspects of the software. Users can also choose to access machine and patient 

functions through the file menus or directly through the 3D interface. 

The 3D work interface allows for direct manipulation of the C-arm machine and positioning of the 

monitors. Users can move independently throughout the environment whilst interacting with 

equipment. 

The Menus 
The menus consist of seven independent headings. Each menu heading contains one or more drop- 
down sublevels. The menu items and their drop-downs are detailed below. 

The 'File' menu gives users access to commonly used commands and contains two items. 

Menu Item Description 

Return to Main Return to the module selection panel 

Exit Exit the application 

 

The ‘Equipment’ menu gives users access to commonly used commands and contains three items. 

Menu 
Item 

Description 
Shortcut 

keys 

Base 
Selecting this menu item displays the C-arm base with associated 
controls in the workspace. 

1 

C-arm 
Selecting this menu item displays the c-arm controls in the 
workspace. 

2 

Monitors 
Selecting this menu item displays the dual monitors in the 
workspace. 

3 

 

The ‘Cameras’ menu gives users access to preprogrammed viewpoints within the workspace and 

contains seven items 

Menu Item Description 
Shortcut 

keys 

Radiographer 
Selecting this menu item switches to the ‘first person’ 
radiographer view. This is the default view. 

Ctrl + 1 

X-ray tube 
Selecting this menu item switches to looking through the X-ray 
emitter in the direction of the beam travel. 

Ctrl + 2 

Top 
Selecting this menu item switches to the view above looking 
towards the patient 

Ctrl + 3 

Left 
Selecting this menu item switches to the view from the left 
looking towards the patient 

Ctrl + 4 

Right 
Selecting this menu item switches to the view from the right 
looking towards the patient 

Ctrl + 5 

Front 
Selecting this menu item switches to the view from the front 
(patient’s head) looking towards the patient 

Ctrl + 6 

Rear 
Selecting this menu item switches to the rear (patient’s 
feet) looking towards the patient. 

Ctrl + 7 
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The ‘Tools’ menu contains one item 

Menu Item Description 

Bone 
Selecting this menu item switches to the skeleton of the patient. Selecting it again 
returns to the normal patient view. 

 
 

The ‘Help’ menu contains two items 

Menu Item Description 

Help Selecting this menu item opens the medspace.VR™ user manuals 

About Selecting this menu item provides software details such as current build. 
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The medspace.CA™ Workspace 
The 3D Workspace is where users conduct procedures. All aspects of x-ray acquisition process are 

carried out within this 3D workspace.  Users navigate within the space and interact with equipment. 
 

The main medspace.CA™ 3D workspace. 
 

The medspace.CA™ work environment consists of: 
 

• A digital C-arm x-ray machine with associated exposure panel and image display system 

• A moveable trolley containing the image monitors 

Clicking with the LMB (left mouse button) on any of these above items will display their associated 

interactive controls. Users can navigate freely within the environment whilst selecting items and the 

patient for manipulation. 
 

Refer to the ‘Navigation’ section of this manual for instructions on moving within the environment. 
 

Refer to the ‘Workflow’ section of this manual for instructions on equipment controls and interactivity. 

 
 
 
 
 

The main 3D Workspace 
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Keyboard Functions and Navigating 
There are a few methods for interacting and moving around inside the medspace.VR™ 3D 
environment. 

A combination of keystrokes and mouse buttons should be used to navigate. 
 

Keyboard functions (Directional keys) 
Both the arrow keys and the W,S,A,D keys can be used as directional keys to move around the 
environment. 

 

 
Arrow keys allow the following movement: 
Forward (Up arrow), Backwards (Down arrow), Pan Left (Left arrow) and 
Pan Right (Right Arrow) 

 
W,S,A,D  keys allow the following movement: 
Forward (W Key), Backwards (S Key), Pan Left (A Key) and Pan Right (D 
Key) 

 
 
 

Mouse Functions (Selecting objects and looking around) 
 

The mouse buttons serve various functions.  
 

• Left Mouse Button (LMB) – This button is the action 
button. You can use it to select objects in the 
exhibition and complete input actions such as check 
boxes. 

• Right Mouse Button (RMB) – This button is used to 
rotate about the environment. Hold the RMB down 
and then move your mouse sideways to rotate 
about. Use this in combination with the direction 
keys to move freely around the environment. For 
example, you can simply use the forward and 
backward directional keys to move in those 
directions while holding down the RMB to steer. 

 
    This is a very effective and efficient way to navigate the 

3D environment. 

 
   You can travel faster through the 3D environment by 

holding down the 'SHIFT' key while moving. 

LMB RMB 
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Moving and Turning 
 

Use either the arrow keys or the W,S,A,D keys to move forward, backwards or pan sideways. Use the 
RMB in combination with the directional keys to turn corners and look around. The images below 
demonstrate moving forward in the 3D environment while using the mouse to steer. 

 
 
 
 

 

 

 
OR 

+ 
 

 
Hold down either the Up Arrow key or the W key 

 
and 

 

Hold down the Right Mouse Button while 
moving the mouse sideways 
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Workflow 
The following section describes the tools and procedures used to perform an x-ray. 

The first section is the basics of how to bring up each tool and what it looks like. 

Accessing equipment interactively within the 3D workspace 
Clicking the equipment in the 3D workspace with the LMB or using the shortcut keys will display their 

associated controls. The following section describes how to display and use controls. 
 

The highlights above show the interactive elements within the main workspace. 
 

 
Clicking with the LMB within any of the above highlighted areas will display the associated controls for 

the selected item. 

 
 
 

C-arm with controls 
 
 
 
 
 
 
 
 

 
Image monitor trolley 

C-arm base with controls 
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Individual Equipment Controls 

C-ARM Base Machine Controls 
Clicking anywhere on the Base of the C-ARM machine with the LMB or using the ‘1’ key will display all 

the controls for the machine other than the arm controls. The following interface will display when the 

“Base” has been selected. 
 

C-ARM Base machine controls. 
 

Button Description 

Place Place the C-arm in a starting position around the operating table prior to 

final placement. Top view is usually the most useful camera view for this. 

Rotate +/- Rotate the entire C-arm Base around its central axis. Use the SHIFT key 

while pressing the buttons to move quickly 

Forward/Backward Move the C-arm Base forwards or backwards. Use the SHIFT key while 

pressing the buttons to move quickly. (When machine locks are 

positioned as above). 

Left/Right Pan the C-arm base Left or Right. Use the SHIFT key while pressing the 

buttons to move quickly. (When machine locks are turned 90˚ to above 

image). 

View Standard View the technical standard for the procedure. 

Next Xray Start a new X-ray 

Hide Output Hide the image output window 

C- arm Main Unit Controls description 
 

The controls are separated into three areas, these are: 

• The C-arm base controls for movement and placement 

• The digital panel controls for imaging tasks and raising the C-arm mast 

• The machine locks 

 

 

X-ray output window 

C-arm base controls 

C-arm digital panel controls 
C-arm machine locks 
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Clicking a button or lock with the LMB will activate the associated imaging functionality or movement 

controls. The following buttons are active on the digital control panel 
 

 

C-ARM Arm Controls 
Clicking anywhere on the actual C-arm with the LMB will display the movement controls and C-arm 
locks. C-arm movement and rotation is dependent on which locks are engaged and disengaged. The 
below locks must be clicked to unlock and this in turn will engage the corresponding menu movement. 

 
The C-arm control panel showing movement locks. 

 

Button Description 

Rotate +/- Rotate the C-arm about the Y axis when unlocked. Use the SHIFT key 
while pressing the buttons to move quickly. 

Z Slide +/- Slide the C-arm in and out along the Z axis when unlocked. Use the 
SHIFT key while pressing the buttons to move quickly. 

Z Rotate  +/- Rotate the C-arm about the Z axis when unlocked. Use the SHIFT key 
while pressing the buttons to move quickly 

C-Arm +/- Rotate the imaging arm when unlocked. Use the SHIFT key while 
pressing the buttons to move quickly. 

Movement and placement controls Movement locks 

Raise and lower the C-arm Field size/magnification 

kVp and mAs controls 
(13cm, 18cm, 27cm) 

Single pulse x-ray or 
continuous screening 

Wheel locks 

Monitor display settings Collimation size and rotation 

Prep and exposure buttons 
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Monitor Controls 
Clicking anywhere on the monitor trolley with the LMB will display the trolley movement controls and 

the twin monitors. 
 

C- arm twin monitors and trolley movement controls. 

 

Button Description 

Place Place the monitor trolley in a starting position around the operating 
table prior to final placement. The “top” camera view is usually the 
most useful. 

Rotate +/- Rotate the trolley around the Y axis. 

Longitude +/- Move the trolley longitudinally relative to the table. 

Transverse +/- Move the trolley transversely relative to the table. 

Movement controls 

Monitors 
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Step By Step Guide 
This tutorial will take you through the following steps. 

 

Starting medspace.VR™ 
Selecting a Module and Mode 
Selecting a Tutorial 
Room Preparation and Initial Equipment Placement 
C-arm Movement 
Base Movements 
C-arm Height Adjustment 
Skeleton               View 
kVp and mAs Controls 
Magnification 
Single Pulse and Continuous X-ray Screening 
Monitor Display Settings 
Collimation size and rotation 
Taking  the  Exposure 
Trouble Shooting 

 
 

Starting medspace.VR™ 
There are two ways to start the medspace.VR™ program. You can either: 

 
 
 

 Double click the medspace.VR™ icon on the       
desktop with your LMB 

 
OR 

Click the medspace.VR™ start menu shortcut with 
the LMB. 
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Selecting a Module and Mode 
On start the ‘Module’ selection screen will appear. 

 
The ‘Module’ Selection Screen 

 
 

Click on the ‘CA’ button with the LMB. The module selection screen will be replaced with the ‘Mode’ 
selection screen.  

 
The 'Mode' selection screen 

 
 

Click on the ‘Tutorial’ button with the LMB. 
 

Selecting a Tutorial 
Clicking the ‘Tutorial’ button will display the available tutorials panel. You cannot move forward until a 
tutorial has been selected. 

 
 

The Tutorial Selection Panel 
 

In the following example we will be conducting a hip pinning procedure. Select ‘Orthopaedics’ from the 
‘Select Body Area’ column and ‘Rt Hip Pinning AP’ from the ‘Select Anatomy’ column. Click the ‘Ok’ 
button with your LMB. 
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Room Preparation and Initial Equipment Placement 
Clicking the ‘Ok’ button on the Projection Selection Panel will place you in the medspace.VR™ work 
environment. 

 

The medspace.CA™ environment 
 

The first step is to position the C-arm roughly in the correct position. 

 
It is important to note that the best view for initial equipment placement is from above the table using 
the ‘Top’ view -  Ctrl + 1 

 
1. Click on the C-arm base with the LMB or use the short cut key ‘1’ 

2. Click the “Place” button. The C-arm is now ‘attached’ to your mouse and a red rectangle is 

outlined around the table. 

3. Move the C-arm to a good start position relative to the table and surgeon. The C-arm cannot be 

placed inside the boundaries of the rectangle. If the C-arm collides with any other object such as 

the table, patient or surgeon, a sound will be emitted, and the screen will be overlayed with red. 

 
Repeat for monitor placement 

 
4. Click on the Monitor trolley with the LMB or use the short cut key ‘3’. 

5. Click the “Place” button. The Monitor trolley is now ‘attached’ to your mouse and a blue 

rectangle is outlined around the table. 

6. Move the Monitor trolley to a good starting position relative to the table and surgeon. The 

Monitor trolley cannot be placed inside the boundaries of the rectangle. If the trolley collides 

with any other object such as the table, patient or surgeon, a sound will be emitted, and the 

screen will be overlayed with red. 
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Top view prior to placing the C-arm and trolley in a initial starting position 

 

 

Top view showing the boundary area for the C-arm initial placement. 
 

Top view showing the boundary area for the Monitor initial placement. 
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Before the C-Arm is positioned, think about whether the detector or the x ray source is at the top. You 

may need to spin the C-Arm around its ‘Z’ axis and the surgeon does not want you to do that during 

surgery! You will need to consider the full range of movement if a lateral is required. 
 

 

• To alter the C-Arm orientation (detector/tube at the top) select the C-Arm 

• Either 

o Use the drop down menu under “Equipment – C Arm” 

o Click on the C-Arm 

o Use short cut key 2 

• Select the appropriate lock and left click on it to unlock the C-Arm Z axis rotation 

C- arm movement 
There are four ranges of movement of the C-Arm 

 

1. Rotation (wig-wag) of the C-Arm on the base column 
2. Z slide C-Arm slide forward and back with base remaining fixed 
3. Z rotation C-Arm spin left or right of column to alter detector at the top or the bottom 

Z Slide Lock Rotation (wig-wag) Lock C-arm Lock 

Z Rotation Lock 
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4. C-Arm to go from vertical to horizontal C Arm position 
 

To move the C-Arm, click on a lock with the LMB. This will move the lever to either “locked” or 
‘unlocked’ position. 
The corresponding ‘C-arm Movement’ buttons will be enabled. 
Click on the buttons with the LMB to move the C-arm in the chosen direction. 
To speed movement up, press and hold the shift key whilst holding the desired movement key. 

 
This machine is capable of ‘under the table lateral’ when the detector is on top for an AP/PA projection 
and ‘over the table lateral’ when the tube is on top for an AP/PA projection. 

 
 

Base Movements 
To move the base select it either by using the drop down menu; clicking on the base of the C-Arm or 
short cut key 1 

 

Table 1 Movement forward and backward (lock lever facing end on) 

 
 

Rotation and left and right (when directional levers are sideways) 
 

Lock levers indicate the direction of movement. Click on the lever and it will alternate between 
forward/backward and left/right. 
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C-Arm Height Adjustment 
To raise the height of the C-Arm on the base, click and hold with the LMB on the up and down arrows on 
the base console. 

 
 

Monitor Movement 
Click on the Monitor trolley with the LMB or use the short cut key ‘3’ 
The monitors can be rotated, moved longitudinally and moved transversely 

 

Top view showing monitor controls 
 

Place the monitors using the ‘Place’ button. 
Once placed where you want it, click on the movement buttons to finely adjust the final position. 
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Skeleton View 
Skeleton view can be enabled through the ‘Tools’ menu by selecting the ‘Bone’ option. 
Alternatively use the shortcut key Ctrl + 8. 

 

Skeleton view 
 

kVp and mAs Controls 
Once the C-arm has been positioned in the correct position the exposure settings can be set. The kVp 
and mAs controls are located on the C-arm base. Select the base by either using the dropdown menus, 
the shortcut keys or simply clicking on the C-arm base with the LMB. 

 

C- arm exposure controls 
 

Use the Up/Down buttons to adjust both kVa and mAs settings by clicking on the buttons with the LMB. 
Each mouse click will result in an increment of one unit. The resulting setting will be displayed on the 
digital screen above the buttons in real-time. 
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Field Size/Magnification 
The C-arm allows for set field size of 13cm, 18cm and 27cm. 

 

Magnification settings 
 

 

To change the field size, simply click on the magnification button with your LMB. Each time you click the 
button the field size decreases as the magnification will increase. To set a less magnified setting, simply 
continue to click the button until the field size cycles to the setting you want. 

 

Single Pulse and Continuous X-ray Screening 
The C-arm allows you to switch between single pulse X-ray mode and continuous screening. 

 

Continuous and Pulse screening options 
 

To switch between Pulse and Screening modes, click the appropriate button on the console with your 
LMB. The mode will be displayed on the digital screen above the buttons. 
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Monitor Display Settings 
The C-arm allows you to manipulate the monitor output images. The monitor display setting allows you 
to perform a range of image functions. 

 

Monitor display settings 
 

The following display settings are available and can be activated by clicking on the relevant buttons with 
the LMB. 

Image hold - Display the current image on the right-hand monitor 

 
Reverse the image – horizontal or vertical flip 

 

Rotate the image clockwise or anti-clockwise 

 

Adjust the contrast of the image 
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Collimation size and rotation 
The C-arm allows you to manipulate the collimator size and rotation by clicking on the relevant buttons 
on the console. 

 
Collimation size and rotation settings 

 

The following collimation settings are available and can be activated by clicking on the relevant buttons 
with the LMB. 

 

 
 

Taking the Exposure 
Once you have positioned the C-arm where you want it and set relevant exposure settings, you are 

ready to take an exposure. 

Click on the ‘PREP’ button with your LMB and wait for the 

Green light. 

Once the Prep light has come on click the ‘EXP’ button. The red 

LED light will be displayed as the exposure is taken. 

Turn the crosshair light on/off 

 

Adjust the Collimator rotation 

 

Adjust the Collimator clipping 

Adjust the collimation size 
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Trouble Shooting 
 

The machine will not move into position 
 

• Check you are not hitting anything (table, patient, surgeon, monitors etc) 

• Just as in real life, you may need to manipulate more than one lock to gradually manoeuvre the 

c-arm without hitting anything 
 

The patient isn’t correctly lateral so I can’t get a good image 
 

• As in real life, the radiographer has little say in the position of the patient. Therefore, it is the c- 

arm that needs to be angled in order to get the correct projection of the anatomy required. 
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Help and Support 

Support Options: 
Website:  http://medspacevr.com 
Email: support@medspacevr.com 
User Forums: http://www.medspacevr.com/forum/ 

 
 

Please allow 24 hours for support requests to be answered following receipt of your query. 
 

Contact Details: 
medspace.VR™ 
PO Box 3129 
Newmarket , 4051 
Queensland 
Australia 
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